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I. Introduction

A. General Description

The MS4500L is a hand-held, battery powered, corrosion meter capable of measuring and storing data from
all types of Linear Polarization resistance (LPR) corrosion probes. The instrument is light weight,
microprocessor-based, and features a simple, menu-driven interface using a keypad and a backlit graphical
LCD display.

Corrosion rate measurements are made using the Linear Polarization method. Essentially, the instrument
measures the current required to polarize the electrodes of a probe to a known potential. From the
polarization potential and the measured current, polarization resistance can be calculated. Then, using
Faraday’s law, the instantaneous corrosion rate can be calculated from polarization resistance. This
method finds a wide variety of applications since it can be used in conductive and nonconductive
environments such as petroleum, chemical, water, soil, or even atmosphere.

After taking a reading, the instrument displays corrosion rate in mils per year (mpy). The reading can then be
stored to memory or discarded. All stored readings are automatically time and date stamped. Readings are
stored to non-volatile Flash memory which retains data without the need for a battery backup.

The MS4500L High Resolution ER Data Logger can store 16,000 readings per probe on up to 250 different
probes (4 million total). Stored data can be downloaded directly to a USB Flash (“jump”) drive in non-
hazardous areas. Data can be opened and charted using the provided CDMS software, or can be imported
into any standard data analysis (spreadsheet) program such as Microsoft Excel. Data can also be reviewed
and charted on the instrument’s LCD display for quick reference.

B. Principles of Operation

MS4500L High Resolution LPR Data Logger operates on the Linear Polarization Resistance (LPR)
technique and is used in conjunction with an LPR probe.

General corrosion

Linear Polarization Resistance (LPR) is based on the fact that in a corroding electrode the relationship
between icorr and the polarization resistance is given by the following equation: icorr = B Rp, where Rp
= AE Al with AE being the applied voltage and Al the resulting current. Harmonic Distortion Analysis
(HDA) allows the MS4500L to determine icorr without using the Tafel slopes (ba, bc). This is typically
done by applying a low frequency sinusoidal voltage and determining the distance of the resulting
current. The MS4500L accurately measures the general corrosion rate by implementing Harmonic
Distortion Analysis (HDA) to improve the performance of Linear Polarization Resistance (LPR). A process-
specific Stern-Geary voltage (Bharm) is calculated with every measurement cycle through HDA. This
value is then implemented in the LPR corrosion rate calculation resulting in a highly accurate self
adjusting, process specific corrosion rate calculation. The MS4500L can measure the general corrosion
rate from 0 ... 1000 mpy (0 ... 25 mmpy).



Localized Corrosion (Pitting)

Electrochemical Noise (ECN) is the method of monitoring spontaneous fluctuations generated at the
interface of the corroding metal and process solution. As localized corrosion occurs, these fluctuations
increase. The MS4500L monitors these fluctuations on the electrode surfaces for 17 minutes. It then
performs a statistical analysis resulting in a unitless pitting factor value between 0 and 1. A pitting factor
of nearly O represents no localized corrosion activity and a pitting factor of 1 represents high localized
corrosion activity. Independent studies have revealed that a sustained pitting factor of greater than 0.3
is cause for concern and you should investigate the source of the elevated Localized Corrosion rate.

Conductance

Solution resistance is a measure of how easily electricity flows along a certain path through an electrical
element. The reciprocal of the solution resistance is solution conductance. The MS4500L measures
solution resistance in order to more accurately calculate the general corrosion rates. As an added feature
the MS4500L provides you with the solution conductance in units of Siemens as the tertiary variable that
is not scalable. The MS4500L requires a minimum solution conductance of 4 uS in order to provide
reliable corrosion data. The solution conductance value that the MS4500L provides can be used to
approximate solution conductivity by this relationship: Conductivity ( S cm ) = Conductance (S) 19
Solution conductivity is a function of distance. As the electrodes corrode, their sizes and geometry
change causing this correlation to deteriorate. The MS4500L should not be considered as a replacement
for standard conductivity meters.



C. Technical Specifications

Model MS4500L High Resolution LPR Data Logger

Physical Data

Instrument Weight*:

Total Weight w/ Case & Accessories:
Instrument Dimensions*:

6.05cm) Carrying Case Dimensions:
14.92cm) Operating Temperature:
Storage Temperature:

* Includes protective boot.

Measurement Data

2.13 Ib. (0.97 kg)

7.40 Ib. (3.35 kg)

8.57"Lx 4.54"W x 2.38"D (21.77cm x 11.53cm x
14.50"L x 11.38"W x 5.88"D (36.83cm x 28.89cm x
-13° to 140°F (-25° to 60°C)

-13° to 158°F (-25° to 70°C)

Probe Type
Measurement Type
Measurement Unit
Measurement Range(s)
Maximum:

Maximum Measured Error

Factory Settings

Measurement Cycle

Electrical Data

Power Requirements:
MN1500) Max. Probe Cable Distance:
Download Method:

mpy (mils per year) or mmpy (mm per year)
Default Range:

2-Electrode LPR and 3-Electrode LPR
General Corrosion

Localized Corrosion Conductance

Unitless microSiemens (uS)
0 to 40 mpy (0 to 1 mmpy) Default Range: 0.0to 1.0 5to 333,333
1000 mpy (25 mmpy) Low Range: 0.0to 0.3

High Range:  0.3to 1.0

Excitation voltage < 0.05% of full span

Corrosion current measurement <0.2% of full span
B value (Stern Geary value): 25.6 mV

K value (corrosion constant): 11800 (2e- in reaction)
4 to 21 minutes (depends on configuration)

Four AA Batteries - Duracell PC1500 (or Duracell
12 ft (3.6 m)

Directly to certified data transfer unit (in hazardous areas)
To non-certified USB Flash drive (in non-hazardous areasonly)

Hazardous Location Certifications — Intrinsic Safety

USA / Canada

for use in Class | Zone 0 AEx ia [ia]
ICT4 Ga Ex ia [ia] ICT4 Ga

Class I, Division 1, Groups A, B, C& D,
T4 Provides outputs to Class |,

€.

L1STED

Division 1 [Ex ia]
-25°C<Ta<+60°C

Europe and Worldwide

60°C

ATEX Certificate No:
ITS18ATEX203161X IECEx Certificate

I11(1) G Exia [ia]
IIC T4 Ga (ATEX and IECEx) - 25°C<Ta< +

(€ &

No: IECEx ETL 18.0007X

Included Accessories

Carrying Case, Probe Cable (1' coiled - 6' extended), Meter Prover, Operation Manual,
Corrosion Data Management Software, Protective Boot

Optional Accessories
Certified Data Transfer Unit
Certified USB Barrier




1. Start-up and Operation
A. Receiving the MS4500LHigh Resolution LPR Data Logger

Check the MS4500L High Resolution Data Logger for any shipping damage when it is first received.
When the unit is unpacked, verify that the following items are included:

e Carrying Case
e Data Logger
e Meter Prover
e User's Manual
e Probe Cable

In the event of shipping damage, quantity shortage, or missing items, it is recommended that the
event is documented immediately and that digital photographs are taken. Any shortages or missing
items should be reported to Metal Samples immediately. In the event of shipping damage, a claim
should be opened with the responsible carrier.

B. Start-Up

CAUTION: Using this product in any way other than that specified within this manual may impair the
intrinsic safety protection.

ATTENTION : l'utilisation de ce produit de toute autre maniére que celle spécifiée dans le présent manuel
peut altérer la protection de sécurité intrinséque.

Start-up of the MS4500L High Resolution Data Logger involves the following steps:
1. Port Details and Probe Connection
2. Power-Up
3. Setup and Operation

1. Port Details and Probe Connection

LPR Probe Cable Connector

USB Port.
For data transfer to
USB Flash Drive Only.

[ O \
\ ]

-

Mini USB Port
For data transfer to PC. T \
WARNING: For use in safe area only.

Attention: Utilisez Seulement

Auxiliary Port
Not for customer use in—
current implementation.




The MS4500L High Resolution Data Logger is supplied with a probe cable, and it can be connected to
the LPR probe, no additional hardware is necessary.

Connect the probe cable ‘Lemo’ connector end to the data logger probe connector ‘J9’ available

on top of the data logger. Connect the other end of the probe cable i.e. probe connector (MS
Connector) to the probe.

2. Power-Up

The unit is supplied with 4 AA batteries installed. The instrument can be powered up by pressing the
‘ON’ button on the Keypad. The Start-up screen with the Metal Samples logo will appear on the
screen; the start-up screen confirms the software version currently running and the SD card status.

SELECT PROBE

MAKE MEASUREMENT

RECALL READINGS

DELETE READINGS

DEVICE SETUP

SET MEASUREMENT TIMER
COMMUNICATIONS

LANGUAGE / IDIOMA / LINGUAGEM
. BACKLIGHT ON/OFF

10. POWER OFF

FW-1890-45L-01.20

1.
2.
3.
4.
53
6.
7.
8.
9

Display Window Power On Button



a. Safe Area Usage

The MS4500L High Resolution Data Logger is approved for use in hazardous areas but can be
used in non-hazardous areas as well.

The data transfer from the unit to PC should be done in a safe area. A certified USB isolator
should be used between the unit and PC for data transfer.

b. Hazardous Area Usage

CAUTION: This section provides general guidelines for hazardous area usage. However,
regardless of anything stated here, the MS4500L High Resolution Data Logger must be used in
full compliance with the control drawing located in Appendix A and all of the local area
requirements. The entity parameters of the unit are given below.

ATTENTION : Cette section fount des directives générales pour l'utilisation en zone dangereuse
Toutefois, et indépendamment de toute déclaration faite ici, L’enregistreur de données de
haute résolution MS4500L doit étre utilise en pleine conformité avec le schéma de contréle
donne en page 20 et avec toutes les exigences du locale zone dangereuse.

J9-USB Port g
Uo = 4.94V Uo=4.94V

lo = 0.332A lo =0.215A
Po=0.410 W Po=0.322 W
Co=1.0 uF

Lo=100 uH

SPECIAL CONDITIONS

e Connection of the equipment to the ET1867 USB barrier (or any other certified barrier used
with the equipment) may only be made while both the barrier and the equipment arelocated
in the non-hazardous area.

¢ External non-metallic materials utilize a conductive coating to prevent the risk of electrostatic
charging. The equipment shall be removed from service if damage to this coating is observed.
Refer to the manufacturer’s instruction manual for further information on the durability and
any chemical vulnerability of this coating.

CONDITIONS PARTICULIERES

¢ La connexion de I'équipement a la barriére USB ET1867 (ou toute autre barriére certifiée
utilisée avec I'équipement) ne doit étre effectuée que lorsque la barriére et I'équipement sont
situés dans une zone non dangereuse.

¢ Les matériaux externes non métalliques utilisent un revétement conducteur pour éviter le
risque de charge électrostatique. L'équipement doit étre retiré du service si des dommagesa
ce revétement sont observés. Reportez-vous au manuel d'instructions du fabricant pour plus
d'informations sur la durabilité et la vulnérabilité chimique de cerevétement.
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CAUTION:

1. Mini USB port to transfer the data from the Data Logger to PC allowed only in safearea
through certified USB barrier.

2. Connection of the equipment to the Metal Samples # ET1867 USB barrier (or any other
certified barrier used with the equipment) may only be made whilst both the barrier and the
equipment are located in the non-hazardous area.

3. Only Certified USB flash drives are allowed to use in Hazardous locations.

4. Conductive coating utilized on the equipment is permanently static dissipative and humidity
independent, no further maintenance is necessary. The unit needs to be returned to the
manufacturer if any damages/scratches noticed on the outer surface of theequipment.

e DO NOT USE CHEMICAL SOLVENTS TO CLEAN THE OUTER SUFRACE OF THE EQUIPMENT OR
BOOT.

ATTENTION:

1. Mini port USB pour transférer les données de I'enregistreur de données au PC autorisé
uniquement dans une zone sire grace a une barriere USBcertifiée.

2. Connexion de I'équipement aux échantillons métalliques # ET1867 La barriere USB (ou toute
autre barriére certifiée utilisée avec I'équipement) ne peut étre fabriquée que si la barriéere et
I'équipement sont situés dans une zone non dangereuse.

3. Seuls les lecteurs flash USB certifiés sont autorisés a utiliser dans des endroits dangereux.

4. Le revétement conducteur utilisé sur I'équipement est en permanence antistatique et
indépendant de I'hnumidité, aucun entretien supplémentaire n'est nécessaire. L'unité doit étre
retournée au fabricant si des dommages / rayures ont été constatés sur la surface extérieure
del'équipement.

e N'UTILISEZ PAS DE SOLVANTS CHIMIQUES POUR NETTOYER LE SUFRACE EXTERNE DE
L'EQUIPEMENT OU DE LA BOTTE.



c. Battery Replacement

The battery compartment is located on the back of the instrument. You must first remove it to access
the battery compartment.

To replace the batteries, first loosen and remove the cover screw, then remove the battery cover to
expose the batteries. Remove the old batteries and replace them with four new 1.5V ‘AA’ size

batteries, being sure to follow the polarity (+/-) symbols in the battery compartment. Replace the
battery cover and cover screw.

WARNING:

e Do not mix old and newbatteries.

e Do not mix batteries of different types (such as alkaline and lithium.)
e Duracell PC1500 battery is required for intrinsic safety.

e The cover screw is used to prevent unauthorized tampering of the batteries and is required to ensure
intrinsic safety.
e Do not over-tighten the cover screw, as this may damage the instrument case.

ATTENTION:
o Avertissement ! Ne mélangez pas des piles neuves et usées.

o Avertissement | Ne mélangez pas des piles de types différents (telles que des piles alcalines etdes
piles lithium.)

o Avertissement ! La pile Duracell PC1500 est requise pour la sécurité intrinséque.

o Avertissement ! La vis du couvercle est utilisé pour éviter toute manipulation non autorisée des
batteries, et est nécessaire pour assurer la sécurité intrinseque.

o Avertissement ! Ne pas trop serrer les vis du couvercle, pour ne pas endommager le boitier de
l'instrument

MS4500L LPR Data Logger
a1 US4y Mol e Compmry A Chrmsen o Awbame Somcoaty st )
52 Mot St Ko Wi AL 250

*-*-f’:;'f::“‘tffmc_s .




3. Setup and Operation

MAIN MENU

The MS4500L allows you to measure metal loss and corrosion rate. Review this section which
describes the functions that display on the Main Menu:

1. SELECT PROBE

2. MAKE MEASUREMENT
3. RECALL READINGS
4. DELETE READINGS
5. DEVICE SETUP
6

7

8

9

1

SET MEASUREMENT TIMER
COMMUNICATIONS
LANGUAGE / IDIOMA / LINGUAGEM
. BACKLIGHT ON/OFF
0. POWER OFF

FW-1890-45L-01.20 10/01/23 12:34:33

Select the functions by using the up or down arrow and pressing ENTER or directly selecting the number
using the keypad and press ENTER. Pressing ‘EXIT’ will return the selection to the first item of the Main
Menu.

a. Select Probe

The display will show as below if you select ‘SELECT PROBE’ menu from the main menu. You can enter a
new probe, delete a probe, or select an existing probe from this section.

ENTER NEW PROBE
DELETE EXISTING PROBE
1000: GC+LC+Con

2500: GC+Con

3500: LC+Con

PRESS ENTER TO SELECT




ENTER NEW PROBE - To enter the ID of a new probe, select ‘ENTER NEW PROBE’; the next

screen allows you to enter the ID number and the type.

a. Enter the Probe ID using the number keys. (Use the Up/Down arrows to scroll between
alphanumeric characters. Use the Right/Left arrows to advance to the next character or
go backto the previous character.) When a 4-digit Probe ID is entered the cursor
automatically advances to the Probe Type field.

b. Enter Probe type by selecting the number of Electrodes. 3 Electrodes is default type.
Electrode type can be changed by using the up/down arrow key. Use the right arrow
to advance to the ‘MEAS.CONFIG(measurement Configuration).

c. Use up/down arrow key to select General corrosion (GC) + Conductance (Con) and Local
Corrosion (LC) individually or in combination.
The following measurement configuration are possible
i 3 Electrodes
a. GC (General Corrosion) +Con (Conductance)
b. LC (Local Corrosion + Con (Conductance)
c. GC (General Corrosion) +LC (local Corrosion) +Con (Conductance)
ii. 2 Electrodes
a. GC (General Corrosion)
b. LC(Local Corrosion)
c. GC(General Corrosion) +LC (Local Corrosion)
Use the Right/Left arrows to advance to the ‘B_VAL (B value), K_VAL and A_VAL.

d. Enter B user Value or Stern-Geary voltage. 25.6mV (Default value). This is relevant in LPR
mode only. This value does not normally need to be changed.

e. Enter K Probe Constant. 11600 (default probe constant) This value is dependent on the
electrode material’s properties.

f. Enter Electrode Area (A Value). Default value= 4.75cm?2. (Electrode area for EL 400

electrodes.)
g. Press ENTER to Save the probe parameters.

PROBE ID: 5385
PROBE TYPE: 3 ELECTRODES
MEAS. CONFIG: GC+Con
B_VAL : 0025.60 mV

K_VAL : 11600.00
A_VAL : 004.75 cm2

PRESS ENTER TO SAVE

SELECT EXISTING PROBE
To assist you with selecting a probe ID, the screen displays a list of all probe IDs currently in

the memory. Select from the list of probes in memory the one for which you wish to run a
function (Make Measurement, Recall Readings and Delete Readings).
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ENTER NEW PROBE
DELETE EXISTING PROBE
1000: GC+LC+Con

2500: GC+Con

3500: LC+Con

PRESS ENTER TO SELECT

o Press the arrow key to select a probe ID.
o Press ENTER.

DELETE EXISTING PROBE
It is occasionally necessary to remove the ID of a probe from memory, for example:
o When the memory bank is full

o When a probe is no longer used

To delete the ID of a probe in memory, select DELETE EXISTING PROBE.

DELETE PROBE

PROBE ID: 1000

USE UP / DOWN ARROW TO CHANGE
PRESS ENTER TO DELETE

1. Enter the probe ID - use the number keys (press the DOWN arrow if you make an error).
Press the UP arrow when you’ve entered the correct IDnumber.

The instrument will confirm your choice of probe ID before deleting it from memory.

11



b. MAKE MEASUREMENT

Select a probe before you run the function

In order for you to run ‘MAKE MEASUREMENT’ ‘RECALL READINGS’ & ‘DELETE READINGS’,
you must have already selected a probe from memory. See ‘SELECT PROBE’ from the Main
menus (page 8).

To take measurement from probes in memory, select ‘MAKE MEASUREMENT’ menu from
the Main Menu:

SELECT PROBE

1
2. MAKE MEASUREMENT

3. RECALL READINGS

4. DELETE READINGS

5. DEVICE SETUP

6. SET MEASUREMENT TIMER

7. COMMUNICATIONS

8. LANGUAGE / IDIOMA / LINGUAGEM
9. BACKLIGHT ON/OFF

10. POWER OFF

FW-1890-45L-01.20

The next screen displays the probe ID that you selected earlier from the Main Menu item
‘SELECT PROBE ’.

PROBE ID:1000 MEASURING
PROBE TYPE :3 ELECTRODE PREVIOUS CURRENT
CONFIG: GC+éon GC : 24.100195MPY  24.170250
B Val : 25.60 mV
K Val : 11600.00 B AVG :25.733713 mV 27.445000 mV
PRESS ENTER TO START PRESS UP ARROW TO REMEASURE

PRESS ENTER TO SAVE

Press ‘ENT’ button to start measuring the probe value. During measurement ‘MEASURING..
message displays on the screen. On completion of measurement the display shows the
probe reading.

Press ‘ENT’ button to save the reading. Press ‘Up’ Arrow to re-measure the probe again.

12



c. RECALL READINGS

Select ‘RECALL READINGS’ to look at data from different dates.

ENTER NEW PROBE
DELETE EXISTING PROBE
1000: GC+LC+Con

2500: GC+Con

3500: LC+Con

PRESS ENTER TO SELECT

Select the probe if it is not already selected to look in to the readings by using up/down
arrows and press ‘ENT’ button. The readings of the selected probe will be displayed in the
next screen.

PROBE ID:1000

RDG# DATE TIME GC LC Con

8 04/24/15 18:45 2410 0.04841 0.00727
7 04/24/15 18:45 2410 0.04841 0.00727
6 04/24/15 18:45 2410 0.04841 0.00727
5 04/24/15 18:45 2410 0.04841 0.00727
4 04/24/15 18:45 2410 0.04841 0.00727
3 04/24/15 18:45 2410 0.04841 0.00727
2 04/24/15 18:45 2410 0.04841 0.00727
1 04/24/15 18:45 2410 0.04841 0.00727

PRESS ENTER TO GRAPH

Press ‘ENT’ button on the keypad to plot the graph of the selected probe. The graph will be
displayed on the next screen with metal loss value and corrosion rate.

PROBE ID: 0001
40

DOVOOZME®

o

124 248 372 496
NUMBER OF READINGS

13



d. DELETE READINGS

Select ‘DELETE READINGS’ from Main Menu to erase a reading from memory.
Periodically delete readings to create more free storage area in memory.

ENTER NEW PROBE
DELETE EXISTING PROBE
1000: GC+LC+Con

2500: GC+Con

3500: LC+Con

PRESS ENTER TO SELECT

Select the probe from which the readings need to be deleted by using up/down arrows and
press ‘ENT’ button. The readings of the selected probe will be displayed in the next screen.

PROBE ID:1000

RDG# DATE TIME GC LC Con

8 04/24/15 18:45 2410 0.04841 0.00727
7 04/24/15 18:45 2410 0.04841 0.00727
6 04/24/15 18:45 2410 0.04841 0.00727
5 04/24/15 18:45 2410 0.04841 0.00727
4 04/24/15 18:45 2410 0.04841 0.00727
3 04/24/15 18:45 2410 0.04841 0.00727
2 04/24/15 18:45 2410 0.04841 0.00727
1 04/24/15 18:45 2410 0.04841 0.00727

PRESS ENTER TO DELETE

Select the probe reading (RDG#) number which needs to be deleted by using up/down arrows
and press ‘ENT’ button. The selected probe reading will be deleted permanently from the
instrument memory.

14



e.

DEVICE SETUP
Set Time & Date

Select ‘SET TIME & DATE’ from Main Menu to set the internal clock of the MS4500L
Data Logger. In order for information in memory to be useful and accurate, be sure the
time and date are accurate.

CAUTION: The Time and Date are set at the factory but may need to be adjusted to your
time zone. Also, if you try to change the Date or Time and it conflicts with stored
information, the MS4500L will display N/A.

ATTENTION : ['heure et la date sont définies a I'usine, mais ils peuvent étre ajustées a votre
fuseau horaire. Aussi, si vous essayez de changer la date ou I'heure et que ce ci conflit avec
I'information mémorisée, le MS4500L affichera N/A.

DATE (MM /DD / YY):
04/27/15

TIME (HH:MM):
03: 42 PM

USE LEFT / RIGHT ARROW TO SELECT
USE UP / DOWN ARROW TO CHANGE
PRESS ENTER TO SAVE

Use the numbers on the keypad and the arrow keys to make changes to the time and date.

Press ‘ENT’ button on the keypad to confirm your changes and return to the Main Menu, or
Press ‘EXIT’ button to discard the changes.

15



ii. SET MEASUREMENT PARAMETERS

Select ‘SET MEASUREMENT PARAMETERS’ menu from Device Setup menu to set the parameters
for the measurement. These settings are common for all probe selection.

MEASUREMENT MODE : LPR

MEASUREMENT UNIT : MPY

USE LEFT / RIGHT ARROW TO SELECT
USE UP / DOWN ARROW TO CHANGE
PRESS ENTER TO SAVE

MEASUREMENT MODE
LPR /Dynamic Measurement mode can be selected using the Left/Right arrow key.

LPR Mode: A user defined Stern-Geary voltage (B user) is used for all LPR corrosion rate
calculations. This is the Default setting on MS4500L.

Dynamic mode. A process specific Stern-Geary Voltage (B Value) is calculated with every
measurement cycle through Harmonic Distortion Analysis. This B value is dynamically
implemented in the LPR corrosion rate calculation resulting in a highly accurate self-adjusting,
process specific corrosion rate calculation Set the mode to Dynamic for dynamically.

MEASUREMENT UNIT
MPY/MMPY measurement unit can be selected under measurement unit. Use left /Right arrow

key to select the required unit.

Press ‘ENT’ key to save the changes made.

16



iii. SET LCD CONTRAST
Select ‘SET LCD CONTRAST’ from Device Setup menu to adjust the contrast of the

display and save setting. Use Up/Down arrow key to adjust the contrast and press
‘ENT’ key to save the contrast setting.

CONTRAST SETTING

USE UP/DOWN ARROW TO CHANGE
PRESS ENTER TO SAVE

iv. CLEAR ALL PROBE DATA

Select ‘CLEAR ALL PROBE DATA’ from Device Setup menu to clear the all-probe data.
Press ‘ENT’ button to clear the data or ‘EXIT’ button to cancel the probe data clearing.

CLEAR ALL PROBE INFO?
<EXT>= NO <ENT> = YES

V. DISPLAY DURING MEASUREMENT

Select ‘DISPLAY DURING MEASURMENT’ from Device Setup menu to turn on / turn
off the display during measurement in progress. Use Left/ Right arrow key to enable
/disable the display.
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f. SET MEASUREMENT TIMER

Select ‘SET MEASUREMENT TIMER’ from Main Menu to set automatic probe
reading at set intervals. The MS4500L Data Logger periodically wakes up and takes the
measurement and stores the reading.

Select a probe before you run the function.
In order for you to run MAKE MEASUREMENT, you must have already selected a probe
from memory. See Select Probe ID from the Main menus (see page 8).

ENTER NEW PROBE
DELETE EXISTING PROBE
1000: GC+LC+Con

2500: GC+Con

3500: LC+Con

PRESS ENTER TO SELECT

If the probe is not selected earlier, select the probe from the display. Use Up/Down
arrow keys to select the probe and press ‘ENT’ button.

DATA LOGGING INTERVAL SETUP
PROBE ID : 2500

SELECT DATA LOGGING
INTERVAL: ONCE EVERY 1 HOURS

LOGGING OFF

RIGHT / LEFT ARROW TO TURN ON/OFF
UP/DOWN ARROW TO CHANGE INTERVAL
PRESS ENTER TO SAVE

Use Right/Left arrow keys to turn on/off the data logging. Use Up/Down arrow to
change data logging interval. Minimum can be set as 1 Hours, and maximum can be
set as 99 Days. The unit takes the reading once per set interval.
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g. COMMUNICATIONS

The MS4500L Data Logger has the ability to store readings as they are taken. These
readings can later be transferred to your PC via USB port. To transfer data to a PCitis
necessary to install the Corrosion Data Management Software (included).

To connect to the MS4500L to PC, the use of the Certified USB Barrier Metal Samples Part

H#ET1867 must be used while in in the Non-Hazardous Area only. The connection is made via J8
on the MS4500L to download the Data to the PC.

Mini LISB-B port for data transfer to PC \

_
|
|
]
]
|
I

HIB { ] —— (19 JAE

USB ATO B Cable
Connect to PC

/

Certified USB Barrier — |

Metal Samples Part # ET1867 ]

‘Warming! Connection Shall only e made
whilsl bolh equipmnet and barrier located in
tha mon-hazardous area,

WARNING:
Improper connection to the PC may cause permanent damage to the MS4500L.

AVERTISSEMENT:
Une mauvaise connexion au PC peut causer des dommages permanents au MS4500L.
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To download data from an instrument:

Connecttheinstrumenttoanavailable PCUSB port.

Turn the MS4500L on.

Runthe Corrosion Data Management Software

Openthelnstrument Download Center

Selecttheserial portandinstrument.

Clickthe Download button (ensure that Part Status toggles to “On”).
Select ‘COMMUNICATIONS’ menu from the Main Menu of the instrument.
Select 'TRANSFER ALL’ or Select the Probe data you wish todownload.

TRANSFER ALL

1000: GC+LC+Con
2500: GC+Con
3500: LC+Con

PRESS ENTER TO TRANSFER

Data will beginto transferfromtheinstrumentto the PC and will appearin the data window of the
Instrument Download Center as shown below. Ifthe data appears garbled, the wronginstrument
type has beenselected. Selectanotherinstrument type and try again.

mmmwm

Metal Samples

S Cavrotan Munifonng Syeems

AT L]
Dowenioed
Carilel

tun L.lllhﬂ' cwmhn
mm 'I'ﬁh'!m

m =i | Pt B B et LR

ol
NAR
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If data does not appear in the data window at all, verify that:

e Theinstrumentis connectedto avalidserial or USB port.

e Allcablesaresecurely connected.

e The message “Port Status: On” appearsinthe status bar.

e Therearenoerrorsontheinstrument.

e Ifusinga USB adapter, ensure thatthe device drivers have beeninstalled.

Selecting a Serial Port
When the MS4500L is connected to the USB port it will appear as a virtual COM port. Usethe

Serial Port selection box to select the virtualCOMport number. If the COM port number is
unknown, it can be found in Windows Device Manager under “Ports (COM & LPT)”.

Selecting an Instrument
Use the Instrument option box to select the model of Metal Samples instrument being downloaded.

Thissetsthe appropriate communication parameters, which willbe displayed in the status barat the
bottom of the window (“9600, N,8,1" foran MS1500, “2400,N,8,1” foran MS3500).

Downloading Data
Totoggle the selected port on and off, click the Download button. Togglingthe port on and off

will also clearthe data window.

Onceavalidserial portand instrument have been selected, clickthe Download button to turn the
port on and enable the computer to receive data. If a valid serial port has been selected, the
status bar at the bottom of the window will display the message “Port Status: On”.

If aninvalid serial port has been selected, an error message will appear, and the status bar will display
the message “Port Status: Off”. If this happens, another serial port should be selected.

Saving Data

Tosavethedatainthedatawindow, click the Save button. The datais comma-delimitedASClI text.
Itcan be savedtoastandard text (.txt) file, orit can be saved to acomma-separated values (.csv)file,
which greatly simplifies the process ofimporting the datainto some spread- sheet programs such as

® ®
Excel orQuattroPro .

Printing Data
Toprint the contents of the data window, click the Print button. A print dialogbox will be displayed to

allow printer selection and setup.

Charting Data
Tochartthe contents of the data window, click the Chart Data button. If the data has not yet been

saved, the user will be prompted to do so before the charting process begins. For moreinformation
oncharting data, see the DataAnalysis section.
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Data Analysis

The Data Analysis utility isa convenienttoolfor charting datafrom Metal Samples ERand LPR data
logger instruments. The Data Analysis utility can be opened from the Main Menu, or it can
be opened directly fromthe Instrument Download Center.

Ifthe Data Analysis utility is opened from the Instrument Download Center, the contents of the data
window will be loaded into the chart. However, if the Data Analysis utility is opened directly fromthe
Main Menu, a valid data file must be loaded. The Select File box will open to allow selection of a
datafile.

Loading a Data File

After selecting a data file (or clicking the Chart Data button from the Instrument Download Center) a
status window will display the progress of the file being opened, along with the Instrument Type,
ProbeType, and Probe ID for the datafile.

## Opening Data File

Progress:

Instrument Type: MS1500E

Probe Type: Wire Loop
Probe ID: 1000

o |

Data Table

Afterafile has beensuccessfully loaded, the data will be displayedin the Data Table for review. By
default, all data points will be included in the chart. However, data points can be turned off, or
excluded, from the chart. If the “Excluded” flagappears in the status column for a data

point that data point will not appear in the chart. To toggle the exclude/ include status of a data
point, double-click the data point, or selectthe data pointand click Exclude/Include in the Options
menu.

28 D ata Table Hi=E
Do Helo

READIT & [WACTAL L0 fol] DATE, [dithonetd [ PRRORE 1D [PoqE TerE [STATUS a]

1 240 12rk0 11000 wie Loop |

I < T AT 1 Wee Loop

3 i T4ram 1 e Loop

4 L 71 Ve ¥ 1] Wik Laag

[ 2000 1000 e Loon

] £ 1n wee Loon

7 200 ] ‘wiee Loop

k] 200 1600 weeloap

I-] rd, ] 1 ey Lop

10 EEEY 1300 ‘wer L

1 2.2 {[F1]] o | A Fachadad

1 130 2 1000 \wire Loop Exciuded

11 2510 2Ar L] e Loop Erchaded =
] | |

fo |
Chast Data EXIT

22



Printing Data
The datatable can be printed by clicking Printin the Options menu. A print dialogbox will be displayed

toallow printer selection and setup.

CreatingAChart
To chart the selected data, click the Chart R

Data button, or select Chart Data from the ' LA
Options menu. The chartwillbedisplayedina

new window.

Printing a Chart
A chart can be printed using the Print Chart option in the File menu.

A print dialog box will be displayed to allow printer selection and setup.

Exporting a Chart

Achart can be exported to other applications using the Copy Chart optionin the File menu. This will
copy both the chart and the raw data to the Windows® Clipboard. The chart can then be inserted
into other applications usingthe Paste function. Note: In some applications, using the Paste function
willinsertthe raw datainstead of the chart. In this case, use the Paste Special function, then select
Picturetoinsert the chart.

Chart Tools

e Statistical Data -
The Statistical Data tab at the bottom of the Data Chart

window will display a page with statisticalinformation about s TR
the chart data. If the Statistical Data page is visible, this e
information can be printed by clicking Print Statistical Data
inthe File menu.
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¢ Finding A Data Points Value
Whileviewingthe chart, the value of any data point can be determined by simply clickingit. The value

willbe displayedinthe charts tool-tip box (a small text box that is displayed near the mouse pointer).
If the tool-tip box does not appearimmediately after clicking the data point, hold the mouse pointer
stationary over the chart background fora moment.

e The Tools Menu

Hide Data Markers Chil+D
Show Mean Yalue ChilsM
The Tools menu contains a collection of utilities for viewing and Show Trend Line il
manipulating the chart. The Tools menu can be accessed by clicking ;:’;Em‘”“"’s“"" E:$
Tools on the menu bar, or by right-clicking anywhere on the chart. Data Series Color CuuleL
Zoom In F5
Zoom Out F6
LCalculate Corrosion Rate F7

o Data Markers
Show Data Markers toggles the data markers on and off.

o Mean Value
Show Mean Value toggles the mean value line on and off.

o Trendline
Show Trend Line toggles the trend line on and off.

o Title/FootnoteSetup
Title/Footnote Setup displays awindow that allows the chart titleand footnotes to be toggled

onand off, and to be modified.

o PlotSetup
Plot Setup displays a window that allows configuration of Y-axis scaling, and of the chart type.

TheY-axis can be scaled to defaultvalues by checkingthe Auto Scaling option box. The Y-axis
can be scaled to manual values by un-checking the Auto Scaling box, then entering the
desired values in the Minimum and Maximum fields.

The chart type can be set to Line Chart, Bar Chart, or Area Chart by selecting the
appropriate buttoninthe Chart Type box. The default charttypeis Line Chart.

o Data Series Color
Data Series Color displays a color selection box, which allows the user to select the brush color

forthe plotline. The default colorforthe plotlineis Blue.
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O Zoomlin
Zoom Inallows aregion ofthe chartto be enlarged so that it may be viewedin greater detail.

To enlarge a region of the chart, click on the two data points that define the left and right
boundaries of the region.

In zoom mode, the mouse pointer will change to cross- hair. Whenzoom mode ends, the
mouse pointer will return to its normal state.

Tocancelzoom mode, click Cancel Zoom in from the Tools menu, or simply press the Esckey.

O ZoomOut
Zoom Out restores the initial view of the chart, which displays the full data set.

o CalculateCorrosionRate
If the chart contains ER data, the Calculate Corrosion Rate option willbecome available under

the Toolsmenu. This option allows the corrosion rate to be calculated between any two data
pointson the chart. Tocalculate the corrosion rate click Calculate Corrosion Rate, then click
two data points. The corrosion rate between those two data points will be displayed.

In calculate mode, the mouse pointer will change to an arrow/question mark. When
calculate mode ends, the mouse pointer will return to its normal state.

Tocancela calculation, click Cancel Calculate fromthe Tools menu, or simply press the Esc key.
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h. File Transfer USB

The J9 Connector on the top side of the device allows for transferring of data onto USB flash
drives.

Hazardous Area

In the hazardous area, the Metal Samples Part# ET1650 Certified USB flash drive can be used.
All other non-certified drives must be used in the safe area.

Connection:

'Certified USB flash drive
Metal Samples Part # ET1650

USB Port
For data transfer to
USB Flash Drive Only" 2

CAUTION:
Only certified flash drives may be connected and used in the hazardous location.

ATTENTION:
Seuls les lecteurs flash certifies peuvent étre connecté et utilisé dans I'emplacement dangere

To download the Data from the “Main Menu” select 7. Communications after installing the USB
drive in J9.

TRANSFER ALL
SELECT PROBE 1000: GC+LC+Con
MAKE MEASUREMENT 2500: GC+Con
RECALL READINGS 3500: LC+Con

1
2

3

4. DELETEREADINGS

5. DEVICE SETUP

6. SET MEASUREMENT TIMER

7. COMMUNICATIONS

8. LANGUAGE /IDIOMA / UNGUAGEM
9. BACKUGHT ON/OFF

10. POWEROFF

PRESS ENTER TO TRANSFER

FW-1850.45L-01 100123 123433

The up arrow can be pressed, and you can select download all by pressing ‘ENT’ or you can
individually select the probe you are interested in by scrolling through the list with the arrow
keys and selecting the probe(s) of interest by pressing ‘ENT’ on each one.
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i. LANGUAGE / IDIOMA /LINGUAGEM

Select ‘LANGUAGE / IDIOMA / LINGUAGEM ’' from Main Menu to select the
language.

ENGLISH
ESPANOL
PORTUGUES
FRANCAISE

PRESS ENTER TO SELECT
PRESIONAR ENTPARA
SELECCIONAR PRESSIONAR ENT
PARA AJUSTAR TAPER ENTRER
POUR REGLER

j. BACKLIGHT ON/OFF

Select ‘BACKLIGHT ON/OFF’ from Main Menu to turn the backlight for the LCD
display on or off.

k. POWER OFF

Select ‘POWER OFF’ from Main Menu to turn off the unit.

LOGGING
OFF
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C. Maintenance
Once installed, the MS4500L High Resolution LPR Data Logger requires no maintenance. However, it
is important to verify the following items periodically to ensure continued safe operation.

CAUTION: Before performing any tests or maintenance on the MS4500L High Resolution LPR Data
Logger, ensure that all hazardous area requirements are met.

ATTENTION : Avant d’effectuer tout essai ou entretien de I'enregistreur de données de haute
résolution MS4500L, il faut d’abord s’assurer que toutes les exigences de zone dangereuse soient

remplies.

Inspection Item Frequency
Inspect the rubber boot for any signs of damage. Replace as necessary. Annually
Inspect the probe cable / connector for any signs of damage. Replace as necessary. Annually
Replace the Batteries As needed

Contact Metal Samples for replacement parts or if instrument repair is necessary.

Testing the MS4500L High Resolution ER Data Logger with the Meter Prover

A Meter Prover is provided to allow routine checks of the MS4500L High Resolution LPR Data Logger. The Meter
Prover simulates an LPR probe at a fixed value. To test the unit with the Meter Prover:

1) Connect the Meter Prover to the probe connector.

2) Turn on the MS4500L data logger by pressing the ‘ON’ button.

3) Ensure Device Mode = LPR Mode and B Value = 25.6 mV.

4) Select ‘'MAKE MEASUREMENT’ from the main menu.

5) Press ‘ENT button to start measuring the probe value. During measurement, the
‘MEASURING’ message is displayed on the screen. On completion of the
measurement, the display shows the Meter Prover reading. The output should closely
match the value printed on the Meter Prover label.

If the Data Logger output matches the Meter Prover value, the instrument can be used for probe
measurement by selecting the appropriate probe ID and connecting to the respective probe. If the Data
Logger output shows a significant difference compared to the Meter Prover value, further troubleshooting
may be required. Refer to the Troubleshooting section or contact Metal Samples for further assistance.
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D. Troubleshooting

If the MS4500L High Resolution LPR Data Logger does not seem to perform as expected, check the
following items:

CAUTION: Before performing any tests or maintenance on the MS4500L High Resolution LPR Data
Logger, ensure that all hazardous area requirements are met.

ATTENTION: avant d'effectuer tout essai ou d'entretien sur I'MS4500L haute résolution LPR
Enregistreur de données, s'assurer que toutes les conditions sont remplies pour zone dangereuse.

1. Ensurethatthe probeis operationaland is not completely corroded. This can be done in two ways.
a. Testthe probe with another portable LPR meter if available.

2. Ensure the batteryvoltage.

3. Test the MS4500L High Resolution LPR Data Logger transmitter using the supplied Meter Prover (see

page 24.)

These basic checks should indicate the source of any problem (probe, power supply, wiring, etc.). If it is
determined that the MS4500L High Resolution ER Data Logger is malfunctioning, or if you need further
assistance in troubleshooting, contact Metal Samples Technical Support.

CAUTION: If the MS4500L High Resolution LPR Data Logger transmitter shows any signs of damage,
remove it from service immediately and consult the factory.

ATTENTION: Si 'Emetteur de I'Enregistreur de données de haute résolution présente des signes de
dommages, Alors il faut le retirer du service et consulter I'usine.
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lll. Service and Warranty Information

A. Warranty

Metal Samples warrants that any part of the model MS4500L High Resolution LPR Data Logger and
accessories which proves to be defective in material or workmanship within one year of the date of
original shipment to Purchaser will be repaired or replaced, at Metal Samples option, free of charge. This
warranty does not cover (1) probe assemblies, (2) items expendable in nature, or (3) items subject to
damage from normal wear, misuse or abuse, or failure to follow use and care instructions.

All damaged items are to be shipped at the Purchaser’s expense to and from Metal Samples which shall
have the right to final determination as to the existence and cause of a defect.

The foregoing shall constitute the sole and exclusive remedy of any purchaser of Metal Samples products
for breach of warranty and IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED OR
STATUTORY, INCLUDING THE IMPLIED WARRANTIES OR MERCHANTABILITY AND FITNESS. IN NO EVENT
SHALL METAL SAMPLES BE LIABLE FOR SPECIAL OR CONSEQUENTIAL DAMAGES, OR FOR ANY DELAY IN

THE PERFORMANCE OF THIS WARRANTY DUE TO CAUSES BEYOND ITS CONTROL.

The technical information and suggestions contained herein are believed to be reliable, but they are not to
be construed as warranties since conditions of use are beyond our control.

B. Obtaining Service and Returning the Instrument for Repair

If you experience problems with your instrument, please contact the factory at 256-358-4202 and ask
for customer support for instrumentation. Our customer support department will assist you in
troubleshooting your instrument.

Most issues can be resolved over the phone, but in some cases, it may be necessary to return your
instrument for further evaluation and repair. In this case, please obtain a Return Materials Authorization
(RMA) number from the sales person or support technician. This RMA number will ensure that your
instrument is routed to the correct department when it is received at the factory.

After receipt of an RMA number you may pack your instrument for return. Be sure to pack your instrument
in a sturdy box and to pad it sufficiently to avoid damage during transit. Also be sure to complete the
“Instrument Repair Form” on the next page and include a copy with your repair. This will ensure that the
repair department has sufficient information regarding the problems you are experiencing with your
instrument, as well as the billing, contact, and return shipping details for the repair.

Once you have obtained an RMA number, completed the “Instrument Repair Form”, and packed your
instrument securely, please ship it prepaid to the following address:

Metal Samples

152 Metal Samples Road
Munford, AL 36268
ATTN: RMA#

NOTE: Be sure to list your RMA number in the attention line (shown as blanks in the example above.)

30



C. Instrument Repair Form

This form may be photocopied for use when returning an instrument to Metal Samples for repair.
Please fill in all known information and enclose a copy of the completed form with the instrument.

General Information

Model Serial
Number Number
RMA Date of
Number Purchase*
*If known.

Contact Information for Repair

Contact

Name Company
Phone E-mail
Number Address

Return Shipping Information

Recipient
Name* Company*

Return

Address

*If different than above.

Reason for Return. (Provide as much detail as possible. Attach additional pages if required.)

Invoice Instructions (For non-warranty repairs)

Reference

D Invoice me for the repair pO#

(Requires an open account with Metal samples.)
D Contact me for credit card information
(For security purposes, do not list credit card information on this form..)
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Appendix A: Revision History

Revision Date Changes
0 07/25/2022 | Initial Release
A 10/01/24 Display menu corrections updated

32




Appendix B: Hazardous Area Certification Details

é Doc.Number EXDOC-000029
Metal -_— MS4500L-XX HAZARDOUS AREA CERTIFICATION - [Revision 0
Samples INTRINSIC SAFETY DETAILS Date 07/25/2022
- Page 10f3
USA / Canada Class 1, Zone 0, AEx ia [ia] IIC T4 Ga
Model : MS4500L-HC
-40°C < Ta < +70°C
Only with Xeno Energy XL-205F Cells and
Tadiran TL-4920 Cells
Model : MS4500L-HC
-25°C £ Ta < +60°C
Only with Duracell PC1500 /MN1500 Cells
Worldwide and Europe Exia [ia] ICT4 Ga
Model : MS4500L-HC
-40°C = Ta<£+70°C

Only with Xeno Energy XL-205F Cells and
Tadiran TL4920 Cells

Model : MS4500L-HC

-25°C =< Ta < +60°C

Only with Duracell PC1500 /MN1500 Cells

ATEX Cert. No: ITS18ATEX203161X
IECEx Cert. No: IECEx ETL 18.0007X
X — See special Conditions below

Special Conditions

Connection of the equipment to the ET1867 USB barrier (or any other certified barrier used with
the equipment) may only be made whilst both the barrier and the equipment are located in the
non-hazardous area

La connexion de I'équipement a la barriére USB ET1867 (ou a toute autre barriére certifiée
utilisée avec I'équipement) ne peut étre effectuée que lorsque la barriére et I'équipement
sont situés dans la zone non dangereuse.

External non-metallic materials utilize a conductive coating to prevent the risk of electrostatic
charging. The equipment shall be removed from service if damage to this coating is observed.
Refer to the manufacturer’s instruction manual for further information on the durability and any
chemical vulnerability of this coating.

Les matériaux externes non métalliques utilisent un revétement conducteur pour éviter le risque
de charge électrostatique. L'éguipement doit étre retiré du service si des dommages a ce
revétement sont observés. Reportez-vous au manuel d'instructions du fabricant pour plus
d'informations sur la durabilité et toute vulnérabilité chimique de ce revétement.




—— — MS4500L-XX HAZARDOUS AREA CERTIFICATION -
Metal=—=

Samp|e§ INTRINSIC SAFETY DETAILS

Doc.Number

EXDOC-000029

Revision 0
Date 07/25/2022
Page 20f3

Hazardous Area Installation

CAUTION : This section provides general guidelines for hazardous area wiring. However, regardless of
anything stated here, the MS4500L-XX transmitter must be installed in full compliance with the control
drawing provided Annexure-C and all of the local area requirements.

ATTENTION : Cette section fournit des directives générales pour le cablage en zone dangereuse.

Cependant, indépendamment de tout ce qui est indigué ici, le transmetteur M54500L-XX doit

étre installé en totale conformité avec le schéma de contréle fourni a 'Annexe-C et toutes les
exigences locales.

Entity Parameters

J11: at Probe (common for all models)

Uo:

lo:

Po:

CE

Li:

Co:

Lo:

Jo:

8.61V
0.202A
0.044W
OuF
OpH
1.0uF
18uH

USB Flash Drive {common for all models)

Uo:

lo:

Po:

Ci:
Li:

Co:

Lo:

18

4.93v
747.5mA
923.1mW
39.394uF
1.8uH
12.71uF
0.37uH

:_mini USB

Uo:

lo:

Po:

4.94v
0.215A
0.322W




é Doc.Number EXDOC-000029
Met — MS4500L-XX HAZARDOUS AREA CERTIFICATION - |Revision 0
am 'és?' INTRINSIC SAFETY DETAILS Date 07/25/2022
S p Page 30f3

When replacing the battery packs in Hazardous area, discharge the static charge from
the body using ground strips or other methods.

Use gas analyzers or other type of equipment to ensure the area is non-hazardous before
changing the batteries. Cells in the batteries not allowed to replace in hazardous areas.
Use only with recommended batteries

MS4500L-HCEquipment is intended for use only with Xeno Energy model XL-145F and
Tadiran TL-4920 cells. Use of any other battery in this device may impair intrinsic safety.
MS4500L equipment is intended for use only with Duracell PC1500/MN1500

Do not replace cells unless area is known to be Non-Hazardous.

Lors du remplacement des batteries dans une zone dangereuse, déchargez la charge
statique du corps a I'aide de bandes de masse ou d'autres méthodes.

Utilisez des analyseurs de gaz ou un autre type d'éguipement pour vous assurer que la
zone n'est pas dangereuse avant de changer les piles. Les cellules des batteries ne peuvent
pas étre remplacées dans les zones dangereuses.

Utiliser uniquement avec les piles recommandées

L'équipement MS4500L-HCE est destiné a étre utilisé uniquement avec les cellules Xeno
Energy modéle XL-145F et Tadiran TL-4920. L'utilisation de toute autre batterie dans cet
appareil peut compromettre la sécurité intrinséque.

L'équipement MS4500L est destiné 3 étre utilisé uniquement avec Duracell PC1500/MN1500
Ne remplacez pas les cellules 3 moins que |a zone ne soit connue comme étant

non dangereuse




Appendix C: Drawing

Control Drawing (Hazardous Area Wiring Diagram)
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Model MS4500E/L ER/LPR Data Logger

For use in dry locations.

Suitable for use in ordinary locations.
Intrinsically safe for use in the following areas:
Exia [ia] IIC T4 Ga

-25°C < Ta< +60°C

Class 1, Zone 0, AEx ia [ia] IIC T4 Ga

Class 1, Division 1, Groups A,B,C,&D, T4
Provides outputs to Class 1, Division 1 [Ex ia]

Conforms to the following standards:
ANSI/UL Std. 60079-0, 60079-11 & 61010-1
Cert. to CAN/CSA 60079-0, 60079-11 &
CAN/CSA C22.2 No. 61010-1

ATEX Cert. No: ITS18ATEX203161X
IECEx Cert. No: IECEX ETL 18.0007X

The user must read and follow all instructions found in the MS4500E/L Users Manual.

Warning! Classification requires the use of Duracell PC1500/MN1500 , size AA
batteries. Use of any other battery in this device may impair intrinsic safety.
Warning! To reduce the risk of explosion do not mix old batteries with new batteries,
mix batteries from different manufacturers, or mix batteries of different types.
Warning! To reduce the risk of ignition of a flammable or explosive atmosphere,
batteries must be changed only in a location known to be non-hazardous.

Warning! Substitution of components may impair intrinsic safety.

Pour une utilisation dans des endroits secs

Convient pour une utilisation dans des lieux ordinaires.
Intrinséquement sdr pour I'usage dans les secteurs suivants:
Exia [ia] IIC T4 Ga

-25°C < Ta< +70°C

Class 1, Zone 0, AEx ia [ia] IIC T4 Ga

Class 1, Division 1, Groups A,B,C,&D, T4

Provides outputs to Class 1, Division 1 [Ex ia]

Conforme aux normes suivantes:

ANSI/UL Std. 60079-0, 60079-11 & 61010-1
Cert. to CAN/CSA 60079-0, 60079-11 &
CAN/CSA C22.2 No. 61010-1

L'utilisateur doit lire et suivre toutes les instructions
dans le manuel d'utilisateur MS4500E/L.

Avertissement : La classification exige I'usage de Duracell PC1500 /MN1500

ou piles d'AA de taille. L'usage d'aucune autre pile dans cet appareil peut diminuer
la sécurité intrinséque.

Avertissement : Pour réduire le risque d'explosion ne mélange pas de vieilles piles
avec les nouvelles piles, les piles de mélange des fabricants différents, ou les
piles de mélange de types différents.

Avertissement : Afin de prevenir l'inflammation d'atmospheres dangereuses, ne
changer les batteries que dans des emplacements designes non dangereux
Avertissement : La substitution de composants peut compromettre

la Securite intrinseque

Note: External metallic materials are composed of £15% in total Al, Mg, Ti and Zr and
<7.5% in total Mg, Ti and Zr

NON—-HAZARDOUS LOCATION
Zone non dangereuse

Note 2

Warning! Uncertified consumer flash drives for use in safe area only.
Do not use uncertified flash drives in hazardous location.

dans des locations dangereuses.

Avertissement : les lecteurs flash non certifiés doivent etre utilisés
seulement en zone non dangereux. ne pas utiliser les lecteurs flash

2Uncertified USB Flash Drive

2Uncertified USB Flash Drive

USB Port
For data transfer to
USB Flash Drive Only" 2

USB Cable Type A Male
to Type A Female
(Maximum 3 Meters)

Zone dangereuse

HAZARDOUS (CLASSIFIED) LOCATION
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Note 1
Warning! Only certified flash drives may be
connected and used in the hazardous location.
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ER/LPR Probe Extension Cable (Optional)

/_ (Sold Separately)

Avertissement : Seuls les lecteurs flash
certifiés peuvent étre connecté et utilisé dans
I'emplacement dangereux.

'Certified USB

Flash Drive
Metal Samples
Part # ET1650

'Certified USB
Flash Drive

Metal Samples
Part # ET1650

to

Type A Female
(Maximum

3 Meters)

USB Cable
Iﬁ Type A Male
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USB Port
For data transfer to v

USB Flash Drive Only'2

Maximum extension cable length*: 500 ft (152 m)
Ccable < 1.0 yF
Lcable < 100 uH

*Maximum cable length for intrinsic safety purposes. Functional limit
may be considerably less. Consult factory for more information.

WARNING! Extension cable to terminate with standard ER/LPR
corrosion probe only. Extension cable must not be connected to

non-certified equipment, or exit the hazardous location.

longueur maximale de cable d'extension* 152m
Ccable < 1.0 yF
Lcable < 100 uH

*longueur maximale de céble pour des raisons de sécurité |
intrinséques. limite fonctionnelle peut étre beaucoup moins. -;u

consulter l'usine pour de plus amples renseignements.

AVERTISSEMENT! céble d'extension pour connecter avec ER/LPR
a la corrosion sonder seulement. cable d'extension ne doit pas étre
raccordé a I'équipement non certifié. cable d'extension ne doit pas

quitter la zone dangereuse.

Probe Cable
/ (6" Extended Length)

Standard ER/LPR Corrosion Probe
(Sold Separately)

ER/LPR Probe Cable Connector

J11 - ER Probe Cable

Mini USB-B port for data transfer to PC ‘\/
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USB A TO B Cable
Connect to PC

Certified USB Barrier
Metal Samples Part # ET1867

Connector Entity Parameters

J11 - LPR Probe Cable
Connector Entity Parameters
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LPR option and USB cable option added
New Certification Details Added
T4 Temperature modified and T3 added
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Uo = 4.94V
lo = 0.332A

Po = 410mW
Co = 10pF
Lo = 100uH

C;=0uF
L = OuH

Uo = 8.61V
lo = 0.202A
Po = 0.044W
Co = 1.0pF
Lo = 18uH
C;=0uF

L = OpH

/— Model MS4500E/L-** ER/LPR Data Logger
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Modified Entity Parameters in NOTE
Added Entity Parameters to NOTE for J8, removed Um from NOTE 1 and J9
Deleted NOTE 3 and USB Isolator and updated J8 parameters

DESCRIPTION

Warning! Connection Shall only be made f f f LU

whilst both equipmnet and barrier located in oS

the non-hazardous area. S
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